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Document Structure and General Principle 

Synoptic 

The principle is to generate an electrodes document using the core/cavity block's part document in which you can 
model the shape of the electrodes based on the faces of the shape to be burnt. Each resulting electrode will be a 
part document. 

 

Reference system of electrodes 

By convention, we will use the Z- axis of the electrodes document's absolute frame as the plunge direction of 
electrodes. 
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Exercise 1: Creating an Electrode Using the Wizard 

Importing the package 

• From the Home tab,  import the project named TopSolid-Electrode Training.TopPkg. 

Preparing the core block 

• Open the part document named Core Block. 

Creating the frame origin for electrode positioning 

• From the Construction tab, create a  constrained frame. Select the part's parting surface as the support 
plane. 

• Select the right face as the first plane and the left face as the second plane for the first constraint as shown 
below. 

• Select the front face as the first plane and the back face as the second plane for the second constraint as shown 
below. 

• For the orientation, select a block edge as shown below. 

 

• Click on  to confirm the frame. 

• Right-click on the frame that you have just created and select the Others >  Publish Frame command. 
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• Rename the publishing as shown below. 

 

•  Save the document. 

Including the core block in a new electrodes document 

Note: There are many ways to include a part in an electrodes document: 

- Right-click on the part document's tab and select the  Electrodes command. 

- Right-click on the part document in the Project tree and select the  Electrodes command. 

- Create a  new document by selecting an electrodes document, and then  drag and drop the part 
document into the electrodes document from the Project tree. 

• From the Project tree, right-click on the Core Block part document and select the  Electrodes command. 

• Select Blank Template and click on  to confirm the operation. 
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Positioning 

• Right-click on the part in the graphics area and select the  Edit Positioning command. 

A  Frame on Frame constraint has been created. TopSolid automatically positions the published frame on the 
absolute frame, which often saves you time when it relates to positioning. 

 

 
 
 
 
 
 
 
 

• Confirm the positioning by clicking on the  button. 

Warning: If more than one frame has been published, the  Frame on Frame positioning constraint is not created 
and is replaced by a fixed constraint. 
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Removing the drillings 

Removing the drillings makes it easier to create electrodes when there is, for example, an ejector in the area to be 
eroded. 

• From the Electrode tab, select the  Drillings Detection command. 

 

• Click on the  Next icon. The  Removing Cooling Circuits and Drillings command launches automatically. 

• Select Cap as the heal type. 

 

• Click on  to confirm the operation. 

Warning: This command is only available in the preparation stage. 

Selecting the origins 

We are going to define the different frames of the electrode: 

- Machining frame 
- Machining positioning frame 
- EDM frame 

EDM frame    Machining frame  
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• From the Electrode tab's drop-down menu, select the  Electrodes Frames command. 

• Select Base bottom frame as the machining frame, machining positioning frame and EDM frame. 

 

• Click on  to confirm the operation. 

Note: The EDM frame corresponds to the electrode's frame and will later be used to dimension the positions of the 
electrodes in the drafting document. It can also be used as a reference for the coordinates of control points. 

Creating an electrode using the wizard 

The creation of an electrode is done in three steps: 

- Creating the shells (area to be eroded) 
- Creating the eroding shape 
- Creating the electrode 

• Select the  Electrode Wizard command. The  Shells command launches automatically. 

• Select the  Faces mode, and then use the rotary picking technique to select all the pocket's faces as shown 
below. 

 

• Click on  to confirm the operation. 
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The  Eroding Shape command launches automatically. 

• Adjust the following settings. 

 

Note: If the spark gap is applied, the faces of the eroding shape are offset by the spark gap value. However, if the 
spark gap is theoretical, the faces are not offset, but the information is retrieved in the machining. 

• Click on  to confirm the operation. 
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The  Electrode command starts automatically. 

• Adjust the following settings. 

  

• Click on  to confirm the operation. 

A part document for the electrode is then created in the Project tree, within the electrodes document. 
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Note 1: The base dimensions are calculated automatically based on the margin defined in the Electrodes section of 
the Electrodes document's Options tree. 

 

Note 2: If you open the part document of the electrode and you switch to  Analysis Stage, you can find the 
machining and EDM frames. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 3: The icon bar at the bottom right of the graphics area lets you easily hide or show the main elements of the 
document. 

 

 : Hide/Show Shapes to Erode 

 : Hide/Show Shells 

 : Hide/Show Eroding Shapes 

: Hide/Show Electrodes 

•  Save the document. 
  

EDM Machining 
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Exercise 2: Electrode and Shell by Face Selection 

 

Creating the shell 

• Select the  Shells command. 

• Select the following inner faces of the pocket framed in red in the above image as shown below by using the 
rotary picking technique if necessary. 

  

• Click on  to confirm the operation. 

• Click on the  Hide/Show Shapes to Erode icon to hide the block. 
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• From the Surface tab, create two  lofted surfaces based on the shell edges. 

 

•  Sew these two surfaces to the shell. 

•  Extend the surface to 1mm as shown below. 

 

• Click on  to confirm the operation. 
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Creating the eroding shape 

• Select the  Eroding Shape command and adjust the following settings. 

 

• Click on  to confirm the operation. 

In order to guarantee the sharp angles on the eroded shape and to facilitate the realization of the electrode, we 
are going to break down this electrode into two parts.  
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Creating a second eroding shape using the Shape mode 

• From the Shape tab,  trim the eroding shape with a plane.  

• Check the Keep trimmed side box in the Advanced Options dialog box. 

  

• Click on  to confirm the operation. 

• From the Shapes folder in the Entities tree, hide the eroding shape 2. 

• On the trimmed side, perform a  face modification operation in order to offset the following face by 1mm. 
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• Select the  Eroding Shape command, select the  Shape mode, and then adjust the following settings. 

  

• Click on  to confirm the operation. 
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Creating the electrode 

• Select the  Electrode command and select eroding shape 2. 

  

• Click on  to confirm the operation. 

Note: Once the electrode has been created, it appears in the Parts folder in the Entities tree. 
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• Repeat the procedure for eroding shape 3. 

  

• Click on  to confirm the operation. 

•  Save the document. 
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Exercise 3: Multiple Electrodes and Shell by Edge Selection 

 

Creating the shell 

• Select the  Shells command using the  Edges mode. Select the following edges. 

 

To complete the loop, we will create the last segment. 

• Click on the  icon and select the  Imprint command. 
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• Select the  By two points mode. 

  

• Click on  to confirm the imprint and the shell. 

Creating the eroding shape 

• Select the  Eroding Shape command and select the previously created shell. 

  

• Click on  to confirm the operation.  
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• From the Shape tab, perform a  face modification operation to offset the electrode from the part by 3mm. 

 

• Click on  to confirm the operation. 

Creating electrodes 

• Select the  Pattern Union command and adjust the following settings. 

 

• To define the axis of rotation, select the midpoint of the electrode as the start point and the Absolute Z Axis 
as the direction. 

 

• Click on  to confirm the pattern and the pattern union. 
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Creating the electrode 

• Select the  Electrode command and adjust the following settings. 

 

• Click on  to confirm the operation. 

Warning: The base must be centered on the axis of rotation selected during the Pattern union operation. 

Adding fillets on the base 

• Right-click on electrode 4 and select the  In Place Edit command as shown below. 
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• Right-click on one of the vertical edge of the electrode and select the  Fillet command. 

 

• Click on  to confirm the operation. 

• Confirm the in-place editing by clicking on the  button. 

•  Save the document.  
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Exercise 4: Markers, Control Points and Properties 

Orientation markers 

• Select the  Orientation Marker command. Select electrode 4 and adjust the following settings. 

  

• Click on  to confirm the operation. 

• Repeat the operation for the other electrodes. 

•  Save the document. 
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Control points 

The Control Point command allows you to create a significant point on the electrode. This point will be projected 
in the electrode drafting document and can be dimensioned according to the gap applied to the electrode via the 
Control Point command in the drafting document. 

Note: The control point is added to the detailed representation of the electrode part. Therefore, by default it will 
be visible in the detailed drawing of the electrode part. However, in the global drawing of the electrodes document, 
it will not be visible. However, it is possible to add these points manually in the detailed representation of the 
electrodes document. 

• Select the  Control Points command. Select the bottom face of the first electrode. 

 

• Click on  to confirm the operation. 

• Position the control points on the other electrodes. 

Note: In the Origin field, if the EDM frame is selected, the reference for the coordinates of the control point is the 
absolute frame of the electrodes document. 
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Electrode properties 

• Select the  Electrode Properties command. Select the first electrode and enter the following properties. 

 

Note: The electrode properties can be retrieved in a bill of material and a drafting document. As with standard 
properties, you can create user properties. These properties come from the TopSolid Electrode library which must 
be referenced. 

• Repeat the same operation on the other electrodes if necessary. 

• Click on  to confirm the operation. 

•  Save the document.  
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Exercise 5: Theoretical Positions 

Repeating an electrode 

• Create the following  frame on plane. 

 

 
 
 
 
 
 

• Create similar frames on the other grooves. Make sure you invert the X axis on the opposite grooves. 
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•  Repeat electrode 4 using a  pattern on frames. The reference frame is the frame corresponding to the 
position of the first electrode. 

 

• Click on  to confirm the pattern and the repetition. 

 

•  Save the document. 

All the electrodes were machined in the same area. We will therefore impose rotations on them. 

• In the Construction tab, select the  Transformation command. 
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• For the rotation axis, select Axis by Point and Direction. 

 

• For the start point, select the midpoint as shown below and the Absolute Z direction. 

 

   

• Click on  to confirm the transformation. 

• Repeat the same operation on the other electrodes if necessary. 
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Exercise 6: Electrode Bridge 

Creating the shell 

• Select the  Shells command using the  Faces mode. Select the faces of the first pocket using the rotary 
picking technique. 

 

• Click on  to confirm the operation. 

• Create a  plane by point and normal. 

 

• Click on  to confirm the operation. 
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•  Trim the shell using the plane you have just created. 

 

• Click on  to confirm the operation. 

Creating the eroding shape 

• Select the  Eroding shape command. 

 

• Click on  to confirm the operation. 
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• Shift the following face by 5mm using the  Faces Modification command. 

 

Repeating the eroding shape 

•  Repeat the eroding shape using a  linear pattern in  Line by two points mode. 

 

• Click on  to confirm the pattern, and then the repetition. 

• Repeat the operation using a  linear pattern and by selecting the following points as start and end points. 
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Creating the electrode 

• Select the  Electrode command and create the following electrode by selecting the three eroding shapes. 

 

Note: If a predefined manufacturer's stock is used and the Base defined by stock box is checked, the dimensions 
of the selected stock are taken into account for the base. 

• Click on  to confirm the operation. 

•  Save the document.  
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Exercise 7: Wire Electrode 

Creating the shell 

• Switch to  Electrodes Stage. 

 

• Create a  sketch on the highlighted plane as shown below. 

 

• Create the following two  arcs as shown below. 

 

• Confirm the sketch by clicking on the  button.  
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•  Imprint the previously created sketch on the shape to erode. 

 

• Create the following  shell using the  Faces mode. Draw a selection box from left to right as shown 
below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click on  to confirm the operation. 

•  Hide the shape to erode and  hide the eroding shapes. 
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• Select the  Pipe command and create the following two surfaces in order to fill the holes. 

 

•  Sew the two new surfaces to the shell. 

• Click on  to confirm the operation. 

Creating the eroding shape 

• Create the following  eroding shape using the  Shell mode. 

 

• Click on  to confirm the operation. 
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Finishing the electrode 

• Select the  Electrode command and adjust the following settings. 

 

• Click on  to confirm the operation. 

•  Edit the in-place part and create a  sketch on the top plane of the base. 
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• From the 2D Sketch tab's drop-down menu, select the Operations >  Project command and project the 
following edges. 

 

• Click on  to confirm the operation. 

• Right-click in the graphics area and select the  Trim by Profile command. Create the following trimming 
operation. 

 

• Confirm the in-place editing by clicking on the  button. 

•  Save the document. 
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Exercise 8: Electrode Drafting 

Electrode, core block and theoretical positions 

• Select the  Electrodes Draft command. 

• From the Project Templates folder, select the A3 ISO Landscape - Electrode template. 

 

• Click on  to confirm the operation. 

• Select the following options. 

 

• Click on  to confirm the operation. 
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A drawing is created for each electrode. 

 

 

Note: A drafting template must be created beforehand. The method used for creating the template is detailed at a 
later stage. 
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Control point notes 

• Open the drawing of electrode 4. 

• From the Electrode tab, select the  Control Points command. 

• Select the control point, select the Rough gap and place the note. 

 

• Click on  to confirm the operation. 

• Repeat the operation for the semi-finish and finish gaps. 
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Additional Exercise: Drafting all the electrodes 

• Select the  Electrodes Draft command. 

• In the Project Templates folder, select the A3 ISO Landscape – All Electrodes template. 

• Check the All Electrodes box and uncheck the Multiple draftings box. 

 

 

Note: If more than one electrode is selected in the command, the Multiple draftings option is used to create one 
drafting document per electrode. If the option is unchecked, only one drawing will be created, with a global view 
of all the electrodes.  
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Exercise 9: Including Mandrels 

Component search 

• Open the electrodes document named Core Block. 

• Click on the  Quick Search icon at the top right of the screen. 

• Adjust the following settings. 

 

• Click on the  icon to run the search. 

The following search results are displayed. 

 

• Close the quick search dialog box. 
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Including the mandrel 

•  Drag the Mandrel - Base 16 x 16 part to the graphics area. 

• Select the electrode 4 as the destination. 

The mandrel is automatically positioned on the electrode. 

 
 
 
 
 
 
 

• Click on  to confirm the operation. 

Note: To position the mandrel, a  Frame on Frame constraint is automatically created between the base frame 
of the mandrel (position to be defined when the mandrel function is provided) and the base frame of the electrode 
(above the base). 
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Exercise 10: Creating electrodes on several parts 

Preparing the cavity block 

• Open the part document named P1.Cavity block. 

• Create the origin frame for electrode positioning as shown below. 

• Publish the frame. 

 

•  Save and close the document. 

• Create an electrodes document using a blank template and name it P1.Cavity block – Electrodes. 

•  Drag the P1.Cavity block part document into the graphics area. This automatically creates a fixity constraint 
for the first inclusion. 

• From the Entities tree, remove the fixity constraint. 

• Edit positioning 1 and create a  frame on frame constraint with the published frame. 

We are now going to include the Spindle part document. 

•  Drag the Spindle part document into the graphics area and constrain the spindle in its housing as shown 
below. 

 

• Confirm the positioning. 

Note: Only part documents can be included in an electrodes document. 
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• In the Preparation step, select the  Shapes to burn command from the Electrode tab. 

The Shapes to burn command allows you to create a set of shapes to be burnt from the part or parts included in 
the electrodes document. 

• Select the spindle and the block as the parts to burn. 

• Switch to Electrodes stage. 

• In the Electrode tab, select the  Shape To Erode command and keep the default values as shown below. 

 

The Shape To Erode command allows you to create a set of shapes to be eroded from the set of shapes to be burnt 
that were previously created in the document. The electrodes will be defined from these shapes. 

• Remove the drillings if necessary. 

• Select the frames using the  Electrodes Frames (machining, machining positioning and EDM) command. 

Creating the electrode on two parts 

• Launch the  Electrode Wizard command in  Edges mode. 

• Select the outer edge of the shape as shown below. 

 

• Create the electrode using a cylindrical base. 
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We will clear the bottom face of the cone. 

 

•  Edit the part in-place and offset the face of the shape by 1,5mm using the  Faces Modification 
command. 

• Add a 1mm connection radius to the bottom to obtain the result as shown below. 

 

• Confirm the in-place editing. 
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Creating an electrode with face removal 

In the Shells dialog box, the Remove faces option allows you to remove the faces on the shape to be eroded 
selected to create the shell. Several types of healing are available and are identical to those of the Delete command. 

In addition, the  Parts to erode command allows you to create part(s) from the final state of the shapes to be 
eroded (i.e. possibly without drillings and cavities eroded by the electrodes). 

• Select the  Shells command using the  Edges mode and then select the following edges. 

• Check the Remove faces box and select Extend as the heal type as shown below. 

  

• Create a second shell by removing the faces to obtain the result as shown below. 
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• Create the eroding shape using the first shell. 
 

 
Shell no.1   Eroding shape no.1 

• Using the  Removing command, delete the superfluous faces and select Extend as the heal type. 

 

•  Extend the face using the  Faces Modification command. 
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• Limit the bottom of the electrode in relation to the face of the part and select the  Electrode command to 
obtain the result as shown below. 

 

• Repeat the same procedure for the second shell to obtain the result as shown below. 

 

On the part, you can plunge the first electrode in several places. 

• Repeat the first electrode using a linear pattern with a value of 53mm. 
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Collision check 

To check the position of the repetitions, we will use the Collisions command. 

• Select the  Collisions command and adjust the following settings. 

 

We automatically switch to Analysis mode and a Collisions folder is created in the Entities tree. 
Since we have chosen to update the collision check manually, we have to restart the calculation using the 

 icon to update it. 

Collisions are detected. 

 

Collisions between electrode bases are normal. To prevent them from reappearing as collisions, you can exclude 
them. 
There is still a collision between the repetition of the first electrode and the part. 

• Check the distance between the two areas to be burnt. 

• Modify the pattern of the repetition. 

• Relaunch the collision check. 

Note: When the electrodes are repeated, the burnt areas are not deleted. 

• Delete the burnt areas using the  Removing command. 

Creating the part to be eroded 

We are going to create a part without the areas to be eroded which can be based on to perform the machining 
operations. There are therefore no filled-hole surfaces to be created for the tool paths. 

• Create a folder named Part to be eroded in the Project tree. 

• Select the  Parts to erode command. 

• Click on  to confirm the operation. 

• Select the destination folder.  
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Exercise 11: Multi-directional Electrode 

In this chapter, we will make injection electrodes. 

Creating an additional origin frame 

The Additional Origin Frame command allows you to assign several origin frames to the shape to be eroded and to 
have different orientations. When the electrode is created, you can select the newly created frame as the origin. 

• In the Electrode tab, select the  Additional Origin Frame command. 

• Adjust the settings as shown below. 

 

To create the frame by point and 2 directions constrain, you simply have to orient it along the injection point. 

• Select the injection cone as the Z direction to orient the frame along the injection axis. 

 
  



TopSolid'Electrode  Exercise 11: Multi-directional Electrode 

TopSolid   51 

Creating the electrode 

• Create the shell corresponding to the two injection points. 

• Fill the hole of the shell using the  Removing command. 

  

• Create an eroding shape by selecting the injection cone as the direction. 
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• Create an electrode with the additional origin frame previously created as direction. 

 

Drafting the injection electrode 

To be able to orientate the drawing with the electrode along the Z axis of the erosion machine, we need to create 
a camera. 

• To orientate the view, select the back face of the electrode base and create a normal view to this face. 

• From the Entities tree, right-click on the Cameras folder and select the  Camera From View command in 
order to create a new camera. 

 

• Name the camera Injection. 
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• In the Orientation section, select the injection camera for the main view of the injection drafting. 

 

 

Note: An exercise on the plunge injection electrode along a vector is available in the annex. 
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Exercise 12: Creating an Electrode Part Template 

Introduction 

When an electrode is generated, the template selected to create the part document is blank. 

Accordingly, the part has no material and the physical properties are not calculated, which forces you to apply the 
material and ask for the properties to be calculated manually on each electrode. 

To avoid this, you need to create a specific part template for the electrode. 

Creating the template with calculated stock dimensions 

• Click on the  TopSolid 7 icon and select the File > Document Templates >  Open My Templates 
command. 

• Create an Electrode folder. 

• Create a part document using the Steel Part - Metric template. 

 

• Rename the part document Electrode Template. 

• From the Entities tree, open the Parameters folder and double-click on the Stock Type parameter. 

 

• Select Rectangular from the drop-down list. 

 

• Click on  to confirm the operation. 
• From the Entities tree, open the Parameters > Stock Calculation > Rectangular folders, double-click on the 

BoxXSizeMargin, BoxYSizeMargin and BoxZSizeMargin parameters and enter margin values for the stock 
calculation. 

• Click on  to confirm the operation.  
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• From the Construction tab, select the Parameters > Associate template to > Electrode command. 

 

• Check the Associate the template to: Electrode box and click on  to confirm the operation. 
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Material 

• From the Tools tab, select the  Material and Coating command, uncheck the No material box and select 
the Copper material. 

•  Save the document. 

Note: When creating the electrode, TopSolid will offer to select a document template. 

  

You can also store the electrode template in the Templates > Defaults folder of the project template. In this way, 
the template will be selected by default and TopSolid will not offer again. 
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Exercise 13: Creating Customized Properties 

Introduction 

The gap properties or electrode properties are documents that come from the TopSolid Electrode library by default. 

Other properties can be created in a user library. The simplest way to do this is to copy a property from the TopSolid 
library, paste it into your own library, and then make the necessary changes. 

Copying the gap properties 

• Open the TopSolid Electrode library. 

• From the Gaps folder,  copy the Rough and Finish properties. 

 

• Click on the  TopSolid 7 icon and select the File >  New Library command. 

• Select Blank Template and rename the library User Electrode. 

• Right-click on the library name and create a new  folder named Gaps. 

• Right-click on the folder and  paste the previously copied properties. 

• Rename the new properties User Rough and User Finish. 

• Open the User Rough document. 

 

Note: Do not modify the domain name since this field is used as a link to an electrode's gap. 
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• From the Entities tree, open the Parameters folder, double-click on the Rough parameter and adjust the value 
to 0.6mm. 

• Click on  to confirm the operation. 

•  Save the document. 

• Repeat the procedure with the User Finish document by adjusting the value of the Finish parameter to 0.2mm. 

In this way, when creating the next electrode, the customized gap properties will be available, provided that the 
library in which they are contained is referenced. 

 

Creating an electrode property 

To create a new finishing mode, e.g. CH 21, you simply have to follow the procedure below. 

• Copy the Properties folder from the TopSolid Electrode library and paste it into your User Electrode. 

• Open the Properties folder and then open the Type of finishing mode enumeration document. 
• Add line CH 21. 

•  Save and close the document. 

Note: It is recommended to reference the TopSolid Electrode library to avoid duplicates in the dialog boxes. 
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Annex 1: Customized Marker Component 

Introduction 

This exercise will show you how to create a marker model that calibrates the base, in addition to the chamfer. 

 

The existing models are stored in the TopSolid Electrode library. The simplest thing is to copy one of the models, 
paste it into a user library, rename it, and then make the changes. 

Copying the model 

• Open the TopSolid Electrode library. 

• From the Markers folder, select the Chamfer family document and generic document. 

 

•  Copy the two documents. 

• Open the User Electrode library (created in a previous exercise). 

• Create a new folder and rename it Markers. 

•  Paste the previously copied documents into the new folder. 

• Rename the documents Chamfer + Calibration. 
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Modification 

• Open the part document Chamfer. 

• Right-click on the chamfer sketch and create a new  sketch. 

• Create a  rectangle using the BaseLength and BaseWidth parameters as shown below. 

 

• From the 2D Sketch tab's drop-down menu, select the Operations >  Project command in  Profiles or 
loops mode and project the chamfer shape. 

 
 
 
 
 
 
 

• Click on  to confirm the operation. 
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• From the 2D Sketch tab's drop-down menu, select the Operations >  Boolean command in  Subtraction 
mode and create a Boolean operation based on the two previously created profiles by selecting the rectangle 
as the profile to be modified and the triangle as the tool section. 

 

• Click on  to confirm the operation. 

•  Extrude the contour by checking the Parallelize box and creating two Ch and Cw parameters on the fly for 
the calibration height and width. 

  

• Click on  to confirm the operation. 

•  Unite the new shape with the chamfer shape. Make sure you select the chamfer shape as the shape to 
modify. 

•  Save the document. 
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• Open the family document. 

• From the Entities tree, open the Generics folder and  drag the Ch and Cw parameters to the Drivers folder. 

• Modify the descriptions as shown below. 

 

•  Save the document. 

•  Check the documents into the vault. 

Testing the component 

• Open the electrodes document named Core Block. 

•  Edit the orientation marker of the first electrode. 

• Select the Chamfer + Calibration template and adjust the following settings. 

  

• Click on  to confirm the operation.  
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Annex 2: Creating a Customized Mandrel 

Parasolid import 

• From the TopSolid'Electrode Training Project tree, right-click on the file named electrode_holder and select the 

 Convert Document command. 

 

• Click on  to confirm the operation. 

Providing the Mandrel function 

• From the Tools tab, select the Functions >  Provide Function command. 

• Select the Mandrel function. 

• Click on  to confirm the operation. 

• For the mandrel frame, click on the  icon and create the  frame on plane constrain as shown below. 

  

• Click on  to confirm the operation. 



Annex 2: Creating a Customized Mandrel  TopSolid'Electrode 

64   TopSolid 

• For the base frame, click on the  icon and create the  frame on plane constrain as shown below. 

  

You should obtain the following result. 

  

• Click on  to confirm the operation. 

•  Save the document. 
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Annex 3: Creating a vector plunge electrode 

• Open the electrodes document named P1.Cavity block. 

Creating the electrode 

• Create the shell for the injection electrode. 

• Create the eroding shape as shown below by making sure that the Z axis of frame 1 is selected as the direction. 
Check the Third extension option and select a plane as the limit. 

 

Note: To select the direction, you can click directly on the shell in the graphics area. 

The third extension allows you to create the base along the Z axis of the block. 
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• Create the electrode as shown below. 

 

Note: To create a connection radius, you simply have to edit the part in-place, delete the unnecessary faces and 
select the Fillet command. 

Creating the start position 

• Select the  Repetition command and create a linear pattern by selecting the injection cone as the direction. 

 

• Click on  to confirm the pattern and the repetition. 

•  Save the document. 
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Creating the drafting document 

• Select the  Electrodes Draft command. 

 

To avoid overloading the view, you can create exceptions on the views and apply them to certain parts. 
You can change the color of the lines, to make a part unbreakable, etc. 

• Right-click on the sectional view and select the  Exception command. 

• Create a new style. 
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• Check the Visible lines box. 

• Select the type of line and the color as shown below. 

 

• Click on  to confirm the operation. 

• To remove the hatchings on the starting electrode, right-click on the starting electrode and edit the hatchings. 

• For the type, select Transparent as shown below. 
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You should obtain the following result. 
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Annex 4: Machining an electrode 

Machining an electrode 

• Right-click on the electrodes document to be machined and select the  Machining command. 

• Select the desired machine model. 

• Select the gap to be applied to the electrode. 

Note: These gaps correspond to the theoretical gaps that were selected when designing the electrode. 

 

Note: The electrode gap is applied directly to the tool path. 
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Machining and positioning origins 

Note: If you want the machining positioning frame and the machining frame defined in the electrodes document 
to be taken into account, in the machining document, you simply have to adjust the options as shown below. 

 

• Select a machining method to create the electrode or to machine the electrode in the traditional way. 

Warning: When finishing, you must keep the value of the offset at 0. The gap is automatically applied. The gap 
appears in the NC Operations tree: Rough=0.8 (Rough) (theoretical). 
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Machining verification 

• Check the machining using the  Start in turbo mode command. 

Before launching the comparison command, we will configure this mode. 

• From the Entities tree, select the  Settings command. 

 

• Check the Offset comparison (3D Z-buffer only) box. 

• Check the Electrode gap (if applicable) box. 

 

• Select the  Display comparison command. 
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The part should appear in green if it is finished. The comparison takes into account the gap, as indicated in the color 
legends below. 

 

We performed a roughing electrode operation. To perform a finishing electrode, you simply have to follow the 
procedure below. 

Machining the finishing electrode 

• Copy and paste the rough electrode machining document and rename it Finishing. 

• Open the electrode finishing document. 

• From the NC Operations tree, right-click on Machined Part 1 and select the Others >  Edit Machined Part 
command. 

 

• Select the finishing gap. 

 

• Restart the machining sequence using the  Refresh command. 

•  Save the document.  
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Annex 5: Electrode Drafting Template 

Creating the drafting document 

• Right-click on the TopSolid'Electrode Training project name and create a  drafting. 

• Select Blank Template and click on  to confirm the operation. 

• Rename the drafting document Electrode - End positions. 

• Right-click in the drawing, select the  Format command and select the A3 ISO Landscape format. 

•  Drag the Core Block electrodes document into the graphics area. 

• Adjust the following settings. 

 

• Click on  to confirm the operation. 
• Position the views as shown below. 
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• From the Project tree, drag the electrode 4 into the graphics area, select Electrode Camera, check the 
Associative box and place the view outside of the drawing. 

 

 
 
 
 
 
 

• Click on  to confirm the operation. 
• Place the auxiliary view as shown below in order to produce a perspective view. 

 

• Click on  to confirm the operation. 
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Layout sketch 

Note: The  Layout sketch command allows you to create different rectangles which will be used to position the 

views which will be attached to them. Each view will be placed in a rectangle when using the  Optimize View 
Layout command. 

• From the View tab, select the  Layout Sketch command. 

• Set the dimensions for the profiles as shown below. 

 

• Confirm the layout sketch by clicking on the  button. 

• Select the  Optimize View Layout command. 

View origins 

• Right-click on the main view and  edit the projection. 

• Click on the  Advanced Options icon. In the 3D reference point field, select the Manual option and select 
Absolute Origin Point from the drop-down list. 

 

• Click on  to confirm the operation. 

• Right-click on the main view and select the  Edit Detailing command. 
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• Select the  Symbol command, select the Origin model and place the view's absolute frame. 

 

• Confirm the view detailing by clicking on the  button. 

• Repeat the procedure on the left view. 
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Electrode note and table 

• From the Electrode tab, select the  Automatic Electrode Note command. 

• Select the main view and click on  to confirm the operation. 

 

• Select the  Electrodes Table command. Click on a first point, and then click on a second point to position 
the table. 

 

 
 
 
 
 

 

• Click on  to confirm the operation. 

• Right-click on the first column and select the  Insert Right Column command. 
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• Double-click on the bottom left cell. 

• Click on the  icon to access the properties. 

 

• Open the Standard > Root > General categories and select the Name property. 

 

• Click on  to confirm the operation. 
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• From the Electrode category, insert the Gap values property in the second column. 

 
• Click on  to confirm the operation. 

• Insert the Base dimensions property in the third column. 

 
• Insert the End positions property in the last column. 

 

• Adjust the size of the columns for better readability. 

• Confirm the electrode table by clicking on the  button. 
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Breaking the link 

• To break the link with the Electrodes document, right-click on the first view and select the  Edit Set 
command. 

• In the Source Document field, select Unspecified. 

• Repeat the procedure for the view with the single electrode. 

 

• Click on  to confirm the operation. 

•  Save the document. 

• Copy and paste the drafting document into  My Templates or  Company Templates. 

Note: The drafting template must be used with the  Electrodes Draft command. 
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Name :  .................................................................................................................................................... 

Company :  .................................................................................................................................................... 

Date(s) from  ..............................................................  to  ......................................................................... 
 
By completing this individual evaluation form, you are helping to improve the quality and usefulness of the training provided in the future. Please complete it 
carefully. 

 
Number of people during the course: Onsite at your company? YES □ NO □ 
 
 GENERAL ASSESSMENT  Poor Average Good Excellent 
Overall, this course has been: □ □ □ □ 
 

What grade would you assign?  

 
 LOGISTIC   Poor Average Good Excellent 
Orientation (quality, organization, user-friendliness, etc.) □ □ □ □ 
Physical setup (room, materials, etc.) □ □ □ □ 
 
 TRAINING  Poor Average Good Excellent 
Instructor's teaching method □ □ □ □ 
Group relationship (participation, sharing of experiences) □ □ □ □ 
Quality and clarity of educational materials (documentation) □ □ □ □ 
Balance between Theory and Practice □ □ □ □ 
Consistent presentations with what has been announced □ □ □ □ 
Training Content □ □ □ □ 
 
 DURATION  No Somewhat no Somewhat yes Yes 
Does the overall duration of the course seem appropriate? □ □ □ □ 
If no, was it? Too short □ Too long □ 
 
 PACE   No Somewhat no Somewhat yes Yes 
Does the overall pace of the course seem appropriate? □ □ □ □ 
If no, was it? Too slow □ Too fast □ 
 
 USE OF ACQUIRED KNOWLEDGE IN THIS TRAINING  No Somewhat no Somewhat yes Yes 
Have you found this training to be useful in your work? □ □ □ □ 
Do you think you can put the acquired knowledge into use quickly? □ □ □ □ 
Do you believe that you have achieved your objectives  

upon completion of this course? □ □ □ □ 
 

Comments and suggestions:  ...................................................................................................................................................  

 .........................................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................................  

 .........................................................................................................................................................................................................................................................................  
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